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BAI 9 NGAY22.11.2008 SOAN THEO KS NGUYENTRUONGSINH

TRONG BAI NAY BAN DOWNLPOAD 1 WEBSITE MAU , GIAI NEN VA LUU
TRONG MY DOCUMENTS\MY WEB SITE . DUNG FP MO’ SITE NAY , QUAN
SAT CAU TRUC CUA 1 WEBSITE TRONG CHE PO FOLDERS LIST VA
NAVIGATION . CAC BIEU TUONG VA THANH CONG CU NAVIGATION .
NHAP CAC TRANG TRONG NAVIGATION , HIEN RA NOI DUNG CUA
TRANG VUA NHAP DE CO KHAI NIEM TUNG TRANG .

1. Khi lam viéc v@i cac irng dung Office 2007 khac, ban sé tao ra cac ho sc doc
1ap c6 thé mé ra trong ‘ng dung dé hodc mé ra tir Microsoft Windows
Explorer .

2. Khi lam viéc véi FP ban cé thé tao 1 nhém cac Tép tin két ndi qua lai dé tao
nén 1 Website dua trén FP . Nhu vay Website phai dugc mé tir trong
FrontPage.

3. Ban nhép lén 1 tén Tap tin trong Windows Explorer ciing c6 thé mé dudc Tap
tin d6 , nhung no sé khong mg Site chira tap tin nay.

4. Sau khi mé 1 Website trong FP , ban cé thé xem xét ciu tric ctia né theo 2
cach:

e Trong ché dé Thu Muc ( Folder View ) : Ban cé thé xem va chinh sira cidu
tric Tap tin cha Website . Ban ciing cé thé td chirc cac Files va Folders
tao nén Website bang cach sir dung cac ky thuit tuong tu nhu nhirng
ky thudt minh d3 dung dé td chirc Files va Folders trong Windows
Explorer . Ban c6 thé bd sung cac Folders méi , xéa , di chuyén cac
Folders da cé va xem néi dung cac Folders .

e Trong ché dd Di Chuyén ( Navigation View ) ban c6 thé xem hoéc sira
doi cau tric, di chuyén va t6 chirc phan cip cia cac Trang khac nhau
trong Site . Trong ché& ddé niy , ban cé thé nhdp vao 1 Trang va Ré né
dén vi tri khac trong Website .



THUC HANH VA QUAN SAT CAU TRUC 1 WEBSITE

Ban mé 1 Website Mau ( Website du'dgc tao biang FP ) xem xét ciu tric Tap tin
va ciu trac di chuyén cua né .

Ban Download File Zip 912.14KB :
http://www.upload.coo.vn/download.php?file=15da2579b5c3a518bc459dc2831731fa

Hoac : http://www.live-share.com/files/368113/GardenCo.zip.html
Hoac : http://utbinh.com/ANOV08/GardenCo.zip

Ban giai nén , dat Folder GardenCo vao trong : My Documents \ My Web Sites
Va tién hanh cac bu'dc sau day :

1. Mé FP > Menu File > Nhap lén Folder GardenCo > Open > HOp tac vu
doéng lai va Folders List mé ra hién thi cac Folders va Files cé thé truy
xuat tao nén Website GardenCo trong ché& dd hién thi Folders (Thu
Muc). Ban c6 thé nhap dap 1én 1 Tap tin bat ky d& mé né trong FP . Néu
chua thay hién thi Folders List ban nhdp View > Folders List ( Alt+F1) .
(H1).
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Ghi Chi : Website dua trén FP c6 kém theo cac Thu Muc va Téap tin an
dudc tao ra béi FP dé phuc vu cho cac céng viéc cua né . Viéc xéa hay
thay ddi cac tép tin nay c6 thé lam * pha vé “ SITE do lam héng ciu
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http://www.upload.coo.vn/download.php?file=15da2579b5c3a518bc459dc2831731fa
http://www.live-share.com/files/368113/GardenCo.zip.html
http://utbinh.com/ANOV08/GardenCo.zip

tric di chuyén, lam dirt cac lién két chia né . Vi thé FP sé thiét 1ap ching
la AN . Ban sé khong bao gi& thay cac tap tin nay va sé khong gip phai
tinh hudng nguy hiém do tinh c& xéa hoac thay doi ching .

2. Trong Folders List , nhap dau + trudc moi thu muc dé xem ndi dung cua

ching .

3. Chd Y Hinh Biéu Tugng :
« Biéu Tudng Trang Web (Hinh qua ciu xanh cé gan O Vudng) dudc
dat trudc moi tén tap tin cua Trang trong Website .
e Biéu Tuong Trang Chu ( Hinh ngdi nha ) trudc chir : index.htm .

(H2).
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Microsoft FrontPos;

Nhap Nut Close dong Folders List > Trén Thanh cong cu
Standard, nhap x6 xudng > Nhap Folders List ( Ctrl+F1)
Iam hién thi lai Folders List . O day man hinh , nhap Nuat
Navigation dé chuyén sang ché& dé Navigation .

Ché do thé hién ciu tric di chuyén vé thuc chat 1a 1 ban
do phan cap cho biét cach cac Trang dugc két noi ra sao
trong Site va nhirng lién két nao ban cé thé dat dugc tir
1 Trang bat ky ciing nhu Folders List , ban c6 thé mé
tirng Tap tin bang cach nhap dap vao biéu tugng Trang
hoac Tiéu dé trong Hop I chuyén . (H3).
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e Nhap dap vao biéu tucng Trang feedback.htm > Hién ra ndi dung
cia nd , dong thai hién ra Tab feedback.htm . Muon dong lai noi
dung nay , nhap Phai lén Tab nay > Chon Close . (H4).



Web Site || feedback.htm

|| <body>| [<p3] 4
Nhdp Phdl I1én Tab ndy

Chon CLOSE dé déng nél dung

[*f=l *

’—i """" e ! fcomment: Feedback Form - Customize the form below to collect the information you
need. By default, the form data is saved to a text file on the web server using the
Products i FrontPage Save Results component. Edit the Form Properties to change this behavior.

E R R e A
Class Offerings i

v Tell us what vou think about our web site, our products, our organization, or anything
Press Releases h else that comes to mind. We welcome all of vour comments and suggestions.

’—H’I“a T | Whatkmdofcommentwouldyoul1ketosend? ......................................................................
O and A i \ a p :
N © Complaint ¢ Problem # Suggestion ¢ Praise
Spedials h What about us do you want to comment on?

[choose ane | other: I

| £

LdDesign| B split B Code T Preview ]

4. Nhap Nat Portrait/Landscape dé thay ddi hudng cua ché ddé hién thi
Navigation . (H5).
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5. Zoom Navigation : Nhdp x8 xudng trén Thanh Céng Cu Navigation >
Chon 75% , kich thuéc hinh vé sé thay doi > Nhap Size to Fit dé téi uu
héa phan hién thi cia hé thong di chuyén > Nhap Nat
Portrait/Landscape dé trd lai ché dd hién thi méc dinh .(H6).

[ Web Site

Navigation Q9 =

Flarks for ¥

Flants For ¥

Products O

Flarits For H

Gifts and Ga

Press Releases
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6. Nhap Trang Products ( Khong nhap dau - 6 day Trang nay ) , khong
nhap NGt dé Iam cho né hién ra ndi dung , Trang ndy da dudc t6 mau
xanh . Trén Thanh Cong cu navigation nhap Nuat View Subtree Only
( Hinh Mui tén ) . Chi xem 1 phan cua cau tric di chuyén ( O’ day chi
xem cau tric cua Trang Products ma thoi ) > Nhap Nat View Subtree
Only mét [an nira d€ xem lai toan bd ban dé site .(H7).

[l web Site
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‘ P\antsf‘..w | Flants Fh| ‘ Plantsf..j ‘G\Fts an‘..w
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7. Menu File > Close Site dé déng Website lai > Close .



6 CHE PO HIEN THI WEBSITE FRONTPAGE

BAI 10 NGAY 24.11.2008 SOAN THEO KSNGUYENTRUONGSINH

BAN UPLOAD FOLDER GARDENCO LEN HOST FREE : WWW.110MB.COM BANG
CHUONG TRINH CUTE FTP 8.3 PRO ( FOLDER GARDENCON PA LUU TRONG MY
DOCUMENTS\MY WEB SITES ) . MO' FRONTPAGE > COT TRAI NHAP GARDENCO
TRONG MUC OPEN HAY VAO MENU FILE > CHON OPEN SITE > MY DOCUMENTS >
MY WEB SITES > GARDENCON > OPEN > HIEN RA COT FOLDERS LIST VA VUNG
LAM VIEC . DAY MAN HINH CO 6 NUT DE CHUYEN QUA LAI CAC CHE PO THE HIEN
KHAC NHAU CUA 1 WEBSITE .

1. CHE PO HIEN THI FOLDERS :

Hién thi cac Tap tin va Thu muc thdy dudc ( C6 mdt sd ban khdng bao gi& thiy
dugc vi FP Iam cho né an dé ban khéi x6a nham sé lam vé ciu tric Website )
cua Website dang mé , gom co6 cac chi tiét : Tén — Tiéu dé - Kich thudc — Loai —
Ngay chinh sira sau cung - Ngu@i chinh stra va ghi cha . (H8).
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http://www.110mb.com/
ftp://ftp 8.3/

2. CHE PO HIEN THI REMOTE WEB SITE :

Ché dd nay hién thi thdng tin vé phién ban cua Website (Ban sé thdy ciu tric
trén site cuc bd va site trén may chu gidng ché dd hién thi trén FTP ) . Ban ¢6
thé hiéu chinh cac Tap tin va Thu muc trén May Cuc Bo va trén May Chu trong
ché do nay .

Hién ra cau : Click Remote Web Site Properties ( Nhap nat nay & goc Phai
trén) > Ra HT Remote Web Site Properties , ban chon giao thi'c Upload FTP >
Nhap Remote Website Location la : ftp://utbinhutbinh.110mb.com > Ok .
(H9).

Remote Web Site Properties

Remote ‘Web Site | Optimize HTML | Publishing |

Remote Web server bype:
(:} FrontPage or SharePoint Services
The Remote Web server supports FrontPage Server Extensions or SharePoint Services.,
O webDaY
The Remaote Web server supports Distributed Authoring and Yersioning.
EFTP f——
The Remate Web server supports File Transfer Protocal,
(File System
Use a folder on wour computer or on a nebwork as the Remote Web site,

Remote Web site location:
*——— V| [ Browse. .. ]
FTP directary:

| Frp: ffutbinbutbinb. 1 10mb.com

|:| Use Passive FTP

If vou do not have a Web hosting service, find one that supports the FrontPage Server
Extensions or SharePoint Services by using the Web Presence Provider search page.

Click here ko learn more.

_‘_ (0] ] [ Cancel ]

e Ra HT Name and Password Required , nhap Name : utbinhutbinh va
Password 27091947 > Ok . (H10).

S vy L

This operation requires end-user permission for
Ftp: ) futhinbwtbinh, 110mb. com,

Mame and password are case sensitive,

Marme: |th|:lil'||‘|l.lt|:lil'||‘| +—— | ﬁ
Passwnrd:|******** .1__ |

— | ok || cancel |



ftp://utbinhutbinh.110mb.com/

e Khi ban thao tac két n6i May Cuc Bo PC cta ban va méy Cchu O xa
Server ( Host Free : 110mb.com ) thanh cong , né sé hién thi néi dung
cua 2 may nay . (H11).
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3. CHE PO HIEN THI REPORTS :

Ché dd nay hién thi 31 bao cao co ban vé Website dang mé . Bao cao dudc thé
hién mac dinh la bao cao dudgc md sau cung . Néu khong cé bao cao nao dudc
ma@ trong sudt phién lam viéc hién tai cia FP , mac dinh sé la Site Summary .
Bao cao nay tap hgp tat ca nhirng két qua cua cac bao cao khac . P& xem 1
bao cao bat ky tir trong bao cao Site Summary ,ban chi can nhap vao tén cua
bao cao dudc lién két . Cac bao cao khac nhau cé thé dudgc chon tir Menu
View hoac tur thanh Cong Cu Reporting. Ban dang xem néi dung cua Site
Summary , nhap x8 xuéng dé xem cac Menu Con . (H12).



|

@l websie|

Site Summaty = -| iy - - =l

Sike Summary Counk Size | Description
Files N 27 448kE Al files in the current Web site
- 1 333KE  Picture files in the current Web site {GIF, PG, BMP, etc.)
Shared Content  » S . .

5 247K Files in the current Web site that cannot be reached by starting from your home page

Problems 4 22 201KE  Files in the current Web site that can be reached by starting Fram wour hame page
wWorkFlaw » o OKE Pages in the current Web site exceeding an estimated download time of 30 seconds at Sekbps
- 27 448KE  Files in the current Web site that have not been modified in over 72 days
Usage 4 1] OKE  Files in the current Web site that have been created in the last 30 days

% Hypetlinks 109 All hyperlinks in the current Web site

2 Unverified hypetl. .. z Hyperlinks pointing to unconfirmed target files

& Broken hyperlinks o Hyperlinks pointing to unavailable target files

@ External bvperlinks 2 Hyperlinks pointing tao files outside of the current Web site

% Internal hypetlinks 107 Hyperlinks pointing to other files within the current Web site

@ Component errors 1 Files in the current Web site with components reporting an error

Q Uncompleted tasks 2 Tasks in the current \Web site that are not vet marked completed

[ Unused themes 1 Themes in the current Web site that are not applied ta any file

% Style Sheet Links i} All Style Sheet Links in the current web sice,

Drynamic Web Te... o All files that are associated with a Dynamic Web Template,

<

BaFolders ERemote Web site |[BI Reports | 8oNavigation B Hyperlinks @ Tasks

4. CHE PO THE HIEN NAVIGATION :

Ché& dd nay thé hién 1 cdu tric dudi dang do hoa vé tat ca cac Tap tin da dugc dua
vao trong cdu tric di chuyén cia Werbsite dang mé . D& thém 1 Tap tin da cé vao
trong céu tric di chuyén , ban chi viéc kéo 1 tap tin dé vao trong cira s6 cua ché dd
thé hién Navigation rdi tha vao vi tri thich hgp . Ban ciing cé thé tao cac Tap tin méi

ngay trong ché do thé hién nay .

Pé lam cho ndi dung cua site phu hop véi kich thu'dc cira sé , ban chuyén qua lai giira
ché& do Portrait ( B6 cuc theo chiéu dirng ) va Landsacpe ( B6 cuc theo chiéu ngang )
hoac thu phéong bang cach dung cac Nat trén Thanh Cong Cu Navigation . (H13).

4l Web Site

navigsien  [Thanh Cong Cu NAVIGATION [ 1 0 s & 4 49 o

Tharks far ... h|

‘ Feedhack I}I

‘Welrome bo
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Products

Class Offeri... I] Press Relea... t]

Contact Us I] ‘ Crand & I] ‘ Speials h|

[ I [ 1
Plants for ... I>| Plants For ... I] Plants for H... I] Gifts and Ga.. 1

N
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5. CHE PO HIEN THI HYPERLINKS :

Khi nhap Nat Hyperlinks , FP yéu cau ban nhap turng Site bén Folders List , n6
sé hién ra bi€u dé Hyperlinks tuong (rng . Vi du : Nhap index.htm . Ché dd nay
thé hién cac kién két tir Trang hodc dén Trang dang dudc chon vat ky trong
Website dang mé .Cac lién két noi , Ién két ngoai va lién két Thu Pién T déu
dudc thé hién . Ban cé thé chon 1 Tap tin trong Folders List dé& xem cac lién
két dan dén né hodc lién két xuat phat tir né réi sau dé nhap vao dau + ké bén
Tap tin d€ mé rong phan thé hién . (H14).
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For Help, press F1

6. CHE PO HIEN THI TASK :

Defauk | Custom

Ché& dd nay hién thi cac tac vu da dudc hoan thanh trong Website dang md ,
FP tao ra cac tac vu nay khi ban sur dung Witzard dé tao Website hoac ban
ciing c6 thé tu tao ra cac tac vu cho riéng minh . Véi méi tac vu ban sé thay
Trang thai — Tén va moé ta cia né . Ban ciing cé thé thay tac vu dé dudc gan
cho ai . Mdi tac vu sé dudc gan 1 ché do wu tién Ia ngh Medium hoac Low .
Tac vu la 1 cach thirc hiru hiéu dé theo déi tinh san sang cia 1 Website

.(H15).

[l web site

Tasks

Status Task Assigned To Priority | associated With Wodiied Date Description
@ ot Started  Finish the book Step by Stepreader  High 5/28/2001 3:02... Read and enjoy FrontPa
@ ok Started  Investigats FrontPag..,  Step by Stepreadsr  Medum 5/28/2001 3:39...  View this Web site in sac

N

< |
EFolders 8 Remote Weh site BIReports #aNavigation B Hyperlinks
icdiszzaul 10
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Ban c6 thé chuyén qua lai cac ché do thé hién bang cach nhap vao ché do
mong mudn tir Menu View hodc bang cach nhap vao cac Nat 6 day man hinh.
Menu View ciing cung cap Lénh Page View . ban sé lam phan Ién cong viéc
phat trién cua minh trong ché dd nay .

Links Bai Viét Frontpage 2003

Bai 1 : http://utbinh.com/ANOV08/121108/FP111108.doc
Bai 2 : http://utbinh.com/ANOV08/111108/110MB.doc

Bai 3 : http://utbinh.com/ANOV08/131108/9down.doc

Bai 4 : http://utbinh.com/ANOVO08/131108B/liveshare.doc
Bai 5 : http://utbinh.com/ANOV08/141108/CuteFTP.doc

Bai 6 : http://utbinh.com/ANOV08/151108/bosung.doc

Bai 7 : http://utbinh.com/ANOV08/171108/TEXT_HINH.doc
Bai 8 : http://utbinh.com/ANOV08/181108/giaodien.doc

Links thuc tap Frontpage 2003

http://utbinh.com/ANOV08/121108/site121108/index.htm
http://kimtrang.110mb.com/site121108/index.htm
http://utbinhutbinh.110mb.com/site141108/indexB.htm
http://utbinh.com/ANOV08/site141108/indexB.htm
http://utbinh.com/ANOV08/site161108/index.htm
http://utbinhutbinh.110mb.com/site161108/index.htm
http://utbinh.com/ANOV08/site151108/index.htm
http://utbinhutbinh.110mb.com/site151108/index.htm
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